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Notice
Thank you for ordering a Q Series thermal analysis system from TA Instruments. To ensure that
installation of your system goes as smoothly as possible and has you ready to start evaluating your sample
materials as quickly as possible, we are providing the attached installation information. It includes details
regarding laboratory space, power, and auxiliary requirements, as well as configuration requirements for
the controller (computer). Please review this information carefully and take any appropriate actions prior
to the installation date. To avoid unnecessary delays, and/or additional charges, please ensure that the
requirements specified in this document are met before your TA Instruments Service Representative
arrives. Contact your local TA Instruments Representative if you have any questions.

To arrange for installation of your system, contact our U.S. Service Department 
(302-427-4050) or your local TA Instruments Service Representative.
soft Word® are registered trademarks of the Microsoft Corporation.
Intel Corporation.
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Important: TA Instruments Manual Supplement
Please refer to the TA Manual Supplement to access the following important information supplemental to
this document:

• TA Instruments Trademarks 

• TA Instruments Patents 

• Other Trademarks 

• TA Instruments End-User License Agreement 

• TA Instruments Offices 
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Requirements for the Controller (Computer)
A working thermal analysis system consists of one or more measurement instruments (e.g., DSC, TGA)
and a computer configured with appropriate TA Instruments software (this latter combination is
subsequently referred to as a controller). As a customer, you have two alternatives for configuring a
controller. You can either purchase a computer and have it configured by a TA Instruments Service
representative or you can purchase a suitable computer on your own and configure it at your site. In either
case, the general requirements which follow are the same. 

Before installing the TA Instruments software, you should ensure that the computer system meets the
following specifications:  

In situations where you are supplying the computer, it is assumed that you have 
reviewed these requirements and suitably prepared the controller prior to the 
scheduled system installation by the TA Instruments Service Representative. In 
fact, you will be required to provide hardcopy verification of your system setup 
using the instructions on page 8 before an installation visit will be scheduled.

Description Requirement

Operating system1

1. Install Microsoft Operating System Service Pack, Internet Explorer and/or Direct X (if required). If you 
don't have the required versions of these packages, they can be obtained through the Microsoft web site 
(at www.microsoft.com/downloads) or by using the Microsoft Windows Update mechanism (accessed 
through the Start menu or by accessing http://update.microsoft.com).

Supported Operating Systems:32 & 64-bit versions of Windows XP Professional,  
Vista Business and Ultimate, and Windows 7 Ultimate, Enterprise & Professional2

2. Home version of Windows 7, XP, and/or Vista is not acceptable. Home version is missing certain 
functionality that is needed for optimized analyzer performance and efficiency. 

Processor Inte® l Core™ 2 Duo (2.93 GHz with 3 MB L2 cache) or better

Memory ≥4 GB RAM

Hard drive ≥80 GB free on hard drive

CD-ROM ≥48X CD-ROM or DVD

Screen resolution 1024 x 768 with ≥64K colors

Graphic memory 128 MBfor Windows Vista or Windows 7

Screen (LCD) size 19” or greater (24” wide screen recommended)

The following Microsoft components are automatically installed as part of 
Advantage V4.7 or higher: MS.NET Framework 2.0 and Microsoft Visual C++ 
2005. These components support the latest software development tools used in 
Advantage V4.8, as a result software installation may take longer than in previous 
versions.
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Additional Requirements for Thermal Advantage Q Series™

Description Requirements

Network card 10/100TX PCI Ethernet NIC for Advantage Q-Series™.

Ethernet hub/Switch ethernet cabling 10/100BaseTX Ethernet hub/switch for Advantage Q-Series™. Must be 
EIA-568B Category 5 UTP.

TCP/IP ports Network Services, as well as File & Printer Sharing for Microsoft 
Networks, Client for Microsoft Network, and Internet Protocol (TCP/IP).

User Account Control (UAC) must be disabled for Windows 7 and VISTA to locate 
and connect to instruments through explorer.

Additional Requirements for Universal Analysis

Description Requirements

Support for custom reporting feature 
of data analysis

Microsoft Word® 97 or higher, Microsoft Excel® 97 or higher, and 
Adobe Acrobat Reader (provided with Advantage) are also required.

Color scheme For Vista, Windows Aero is required (other schemes may result in broken 
line display)

Additional Requirements for Instrument Control Software

Description Requirements

User log-in capability While multiple users may still use the “Fast User Switching” function 
when running Windows XP or Vista, only one user at a time may use the 
TA Instruments Q SeriesTM, Thermal, or Rheology Advantage Instrument 
Control software. This limit, which is applicable to most programs, is a 
result of hardware resources that are used by each of these programs.

Additional Requirements for TA Update*

Description Requirements

Connectivity Controller computer must be able to connect to the Internet.1

1. TA Update allows for online software updates. The entry of a user name and password is allowed in cases where 
proxy or firewall authentication is required.

Log-in rights Administrator
Page  6



Free Disk Space Required
To help you determine which components to install, we have provided the following table containing the
approximate amount of free disk space required for installation of the TA Advantage software.

Additional Requirements for VTI-SA/SA+

Description Requirements

Available PCI slot (1/2 height size) For VTI-SA+ camera option only

Software requirements: Microsoft Excel® 2007 or newer with Solver Add In, English version 
(not supplied)

Additional Requirements for TGA-HP50/HP150/HPs

Description Requirements

Software requirements: Microsoft Excel® 2007 or higher with Solver Add In, English version

This amount is above that required for the operating system, plus the other 
software products supplied on the installation CD-ROM. In addition, an extra 15 
MB of free disk space is required during the install process (for temporary install 
files.)

Software Thermal Only
Data Analysis Only 

(Thermal)
Rheology Only Full Installation

Q Series™ 684 MB 29 MB 344 MB 1057 MB
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Other Hardware Considerations
• The computer should be a new computer that is not already attached to other analytical instruments.

• Before the TA Instruments Service Representative will schedule a visit to install new instruments, 

please obtain a hard copy of the Windows® system summary as instructed below to verify that your 
system is adequate. Please fax this verification sheet along with your company identification and 
phone number to TA Instruments Service at 302-427-4054.

Obtaining Hardcopy System Verification For Windows 

1 Select Programs > Accessories > System Tools > System Information from the Start menu.

2 Verify System Summary is highlighted. 

3 Select Edit > Select All then Edit > Copy.

4 Open Notepad or another word processing program.

5 Select Edit > Paste then File > Print.

Other Software Considerations
• Peripherals (e.g., printer) must be from the known Windows compatible list. (See Microsoft's web site 

at http://www.microsoft.com/hwtest for the most current list.)

• TA Instruments is not responsible for resolving issues associated with connections to your corporate 
network. [See further information in the next section.]

• TA Instruments is not responsible for resolving hardware/software conflicts created by the addition of 
third party hardware or software to the computer.

If you print out this summary from this step you will receive all system information 
(more than 50 pages). Follow the remaining steps to copy and print only summary 
information.
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System Configurations

TA Instruments Q Series™ thermal analysis instruments communicate with the controller via TCP/IP. Each
TA Instruments controller requires an Ethernet hub/switch for configuring a local network (i.e., controller,
instrument(s), printer). 

If you want to connect a thermal analysis controller with Q Series instruments to your in-house network,
additional considerations will apply. Review the scenarios shown below for the one that applies to your
situation.

• Controller Purchased from TA Instruments

If you wish to have your TA controller connected to your company network, you must supply a second
network interface card. The controller and Q Series instruments are shipped with pre-assigned (static)
“TA Instruments-compatible” IP addresses. Your MIS/IT department must supply and configure a
second Ethernet card for communication with your in-house network. Your TA Instruments
serviceman can install this second card during start-up of the system. Note: Using this configuration,
you can archive data to another computer on the network or print results on a network printer.

• Software Suite Purchased from TA Instruments

If you wish to have your TA controller connected to your company network you must supply two
network interface cards. Your MIS/IT department should configure one of the Ethernet cards in the
computer that you are supplying for communication with your in-house network and must supply and
install a second card to be used with the TA Q Series instruments. Your TA Instruments service
representative will configure the second Ethernet card during start-up of the system to communicate
with the Q Series instruments. 

Using this configuration, you can archive data to another computer on the network 
or print results on a network printer

Using this configuration, you can archive data to another computer on the network 
or print results on a network printer
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Requirements for an Advantage Integrity™ 
System (Applicable to Q Series™ Thermal 
Instruments Only)
An Advantage Integrity system consists of an instrument, a computer for instrument control, and a
database server. To obtain installation requirements for the instrument and controller computer, refer to the
appropriate sections of this document. The Advantage Integrity systems rely on an Oracle® database
installed on a separate database server. This server can operate with the instrument and controller computer
as part of a LAN or it can reside on a network. The database server and Oracle software can be purchased
from TA Instruments or the customer can supply the server based on the requirements below. Contact TA
Instruments Service at 302-427-4050 (U.S.) or your local TA Instruments office for additional information
required for the installation of Advantage Integrity systems.

Database Server Requirements
The following are the requirements for the Advantage Integrity database system:

• Minimum Hardware Specifications:

• Intel® Core 2 Duo E4600 2.4 GHz Processor

• 2 GB memory

• 250 GB hard drive

• Super Multi DVD±RW (±R DL) drive

• 10/100TX PCI Ethernet NIC network card

• Windows® Server 2003 software or higher
[English language version with English (US) regional settings].

• Oracle 11g Release 1 database software with the appropriate number of named user licenses. Global 
database name and SID must be set to TAInstDB. Unicode character set must be used (AL32UTF8 or 
UTF8).

• The Database Server must be dedicated to the TA Instruments system and not be used as a server for 
other databases or any other type of servers such as file server, print server, etc.

• Available compatible tape drive or DVD+RW drive for database backup. 
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Requirements for Thermal Analysis Instruments
The following section summarizes laboratory requirements by instrument. Each section contains all of the
requirements for that particular instrument. Therefore, some items will be redundant if you have purchased
a multi-instrument system.

Q Series™ Instrument & Accessory Placement
The Q Series base system consists of a controller computer, Q Series instruments, and an optional cooling
accessory. For accessory setup information in addition to what is provided here, refer to “Requirements for
Miscellaneous Thermal Analysis Accessories” on page 34 of this document.

Select a location for the instrument with adequate floor space and a rigid laboratory bench that is level, has
a minimum depth of 76 cm (30 in), and with a length of approximately 183 cm (72 in). Please refer to the
layout shown in the figure below and the table on the next page for component placement.

If you wish to have your TA controller connected to your company network, you must supply two network
interface cards. Your MIS/IT department should configure one of the Ethernet cards in the controller for
communication with your in-house network, and should supply and install a second card to be used with

the TA Q Series instruments. Your TA Instruments service representative will configure the second
Ethernet card during start-up of the system to communicate with the Q Series instruments. 

Using this configuration, you can archive data to another computer on the 
network or print results on a network printer.
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Q Series Instrument Cooling Unit Accessory Location of Cooling Unit

DSC All Q Series
DSC All Q Series
DSC Q2000/Q1000, Q200/Q100
DSC Q2000/Q200/Q20

RCS
LNCS
1

CCS

1. RCS and CCS are optional coolers with PCA in use.

—
—
PCA

Table
Floor
Table
Table

TGA Q500, Q50
TGA Q5000 IR
Q5000 SA

—
—
—

Heat exchanger
Heat exchanger
Heat exchanger

Table/floor
Table/floor
Table/floor

SDT Q600 — — —

TMA Q400 MCA
MCA70

— Table/floor
Floor

DMA Q800 GCA — Floor
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Q Series™ DSCs

Dimensions:
Q20/Q10
Q200, Q100, Q2000, Q1000

Depth 56 cm (22 in), Width 46 cm (18 in), Height 41 cm (16 in)
Depth 56 cm (22 in), Width 46 cm (18 in), Height 48 cm (19 in)

Weight: 25 kg (54 lbs.); 8.6 kg (19 lbs) additional for built-in transformer for 230V 
operation; 4.5 kg (10 lbs) additional for an Autosampler.

Power requirements: 120 VAC, 47–63 Hz, 500 W [4.5 A] (Installation Category II)
230 VAC, 47–63 Hz, 500 W [2.25 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15–35°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, away 
from exposure to direct sunlight and direct air drafts. (Pollution Degree 2 
Environment)
Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Purge Gas(es) Pressure1, 2 
100–140 kPa gauge (15–20 psig)

Cooling Gas (Air) Pressure for use with Finned Air Cooling System1, 3 
170–830 kPa gauge (25–120 psig)

Cooling Gas (Nitrogen) Pressure for use with RCS or LNCS1, 3 
170–830 kPa gauge (25–120 psig)

Base Purge Gas Pressure for use with Quench Cooler, RCS or LNCS1, 3 
100–140 kPa gauge (15–20 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gas and Base Purge Gas are connected to 
the back of the instrument using 1/8-inch (O.D.) polyethylene tubing and Parker fittings. The Cooling 
Gas is connected to the back of the instrument using ¼ inch (O.D.) Polyflame tubing and a Parker fitting. 
(The tubing and fittings are provided in the DSC accessory kit.) Acceptable cell purge gases include air, 
nitrogen, oxygen, argon, and helium. Dry nitrogen should be used as the Base Purge gas. Dry nitrogen 
should also be used as the cooling gas with the RCS and LNCS. Nitrogen that is 99.998% pure and <5 
ppm H20 is recommended.

2. Mass flow controllers (MFC) are a standard feature. Typical purge gas flow rate to the cell is 50 mL/min 
with nitrogen. If your instrument does not have an MFC, an external flow meter is required.

3. Actual cooling gas and base purge gas flow rates are controlled by orifices installed in the DSC

References to “Installation Category” and “Pollution Degree” in this document are 
defined in the safety standards to which this equipment has been evaluated. 

Installation Category II: The local level power distribution system intended to 
power appliances, portable equipment, etc. with smaller transient overvoltages 
than installation category III. For mains supply the minimum and normal category 
is II.

Pollution Degree 2: Normally only non-conductive pollution occurs. Occasionally, 
however, a temporary conductivity caused by condensation must be expected.
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Q20P/PDSC System

Dimensions:
Q20P/Q10P
PDSC cell only

Depth 56 cm (22 in), Width 46 cm (18 in), Height 41 cm (16 in)
Depth 24 cm (9.3 in), Width 22.4 cm (9 in), Height 33 cm (13 in)

Weight:
Q20P/Q10P

PDSC cell only

25 kg (54 lbs.); 8.6 kg (19 lbs) additional for built-in transformer for 230V 
operation; 4.5 kg (10 lbs) additional for an Autosampler.
11 kg (23 lbs)

Power requirements: 120 VAC, 47–63 Hz, 350 W [3 A] (Installation Category II)
230 VAC, 47–63 Hz, 350 W [1.5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15–35°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, away 
from exposure to direct sunlight and direct air drafts. (Pollution Degree 2 
Environment)
Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Q20P/Q10P DSC — No additional requirements PDSC Cell — Customer-
supplied source of clean, dry pressurizing gas (inert, oxidizing, or reducing), and 
all accessory regulators, gauges and tubing1. The gas is usually obtained from a 
gas supply vendor in approved high-pressure tanks. If the PDSC Cell is to be 
operated under vacuum conditions, the customer must supply the vacuum source. 
The cell operating pressure range is from 1 Pa to 7 MPa (0.1 to 1,000 psig). If the 
PDSC Cell is used in the dynamic or constant pressure mode, and an indication of 
flow is required, an appropriate external flow meter must be obtained.
Contact TA Instruments for a listing of suitable gases and vacuum suggestions.

1. All tubing connecting the PDSC Cell to other devices (e.g., gas cylinders, gauges, valves, or regulators) 
should be 3.18-mm (0.125-in) O.D. They must be rated for high pressure service to 21 MPa gauge 
(3,000 psig) and free of hydrocarbons. The gas source regulator must be rated to withstand the source 
pressure and possess two gauges—one to monitor the gas source pressure and the second to monitor the 
regulator output pressure. The regular should cover the experimental range of the PDSC Cell (up to 7 
MPa gauge [1,000 psig]).
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Q5000IR TGA

Dimensions: Depth 56 cm (22 in), Width 47 cm (19 in), Height 61 cm (24 in)

Weight: 37 kg (82 lbs.); 8.2 kg (18 lbs) additional for built-in transformer for 230V 
operation

Power requirements: 120 VAC, 47–63 Hz, 1.2 kW [10 A] (Installation Category II)
230 VAC, 47–63 Hz, 1.2 kW [10 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15–35°C (Note: TGA balance mechanism is sensitive to changes in 
surrounding environmental conditions. For best results, room temperature should 
be regulated to eliminate temperature variations)
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, 
preferably on the ground floor in the building (a marble balance table is 
required for best results), away from pumps, motors, or other devices which 
produce vibrations, and away from exposure to direct sunlight and direct air 
drafts. (Pollution Degree 2 Environment). 
Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Purge Gas(es) Pressure1, 2      
70–140 kPa gauge (10–20 psig)

Cooling Gas (Air) Pressure1 
170–830 kPa gauge (25-120 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gases are connected to the back of the 
instrument using 1/8-inch (O.D.) Polyethylene® tubing and Legris fittings. The Cooling Gas is con-
nected to the back of the instrument using ¼ inch (O.D.) Polyethylene tubing and a Legris fitting. (The 
tubing and fittings are provided in the TGA accessory kit.) Acceptable purge gases include air, nitrogen, 
oxygen, argon and helium.

2. Purge gases are required for the balance and furnace/sample areas. Balance purge gas should always be 
inert to protect the balance assembly. Mass flow controllers (MFC) are a standard feature of the Q5000 
IR. Purge gas flow rates are 10 mL/min and 25 mL/min to the balance and furnace/sample areas respec-
tively.

Atmospheric pressure fluctuation can disturb sensitive TGA measurements. 
Ventilation systems should operate air handlers continuously and efforts should 
be made to minimize short term pressure fluctuations due to opening doors. Vents 
that allow air to move between adjacent rooms through walls, doors, or ceilings 
will help minimize measurement noise.
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Q5000 SA

Dimensions: Depth 56 cm (22 in), Width 47 cm (19 in), Height 61 cm (24 in)

Weight: 40 kg (82 lbs.); 8.2 kg (18 lbs) additional for built-in transformer for 230V 
operation

Power requirements: 120 VAC, 47–63 Hz, [1.5 A] (Installation Category II)
230 VAC, 47–63 Hz, [1.5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15–35°C (Note: TGA balance mechanism is sensitive to changes in 
surrounding environmental conditions. For best results, room temperature should 
be regulated to eliminate temperature variations)
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, 
preferably on the ground floor in the building (a marble balance table is 
required for best results), away from pumps, motors, or other devices which 
produce vibrations, and away from exposure to direct sunlight and direct air 
drafts. (Pollution Degree 2 Environment). 
Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Purge Gas(es) Pressure1, 2    
70–140 kPa gauge (10–20 psig)

Distilled water is required for humidity chamber

1. Purge gases are required for the balance and sample area (humidity chamber). Mass flow controllers 
(MFC) are a standard feature of the Q5000 SA. Purge gas flow rates are 200 mL/min for the humidity 
chamber and 10 mL/min to the balance. A gas dryer is supplied with the Q5000 SA.

2. Nitrogen purge gas is used for both the balance and sample area. The gas used must be dry and free of 
oil, dirt and water. The purge gases are connected to the back of the instrument using 1/8-inch (O.D.) 
Polyethylene® tubing and Legris fittings. (The tubing and fittings are provided in the Q5000 SA acces-
sory kit.)
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Q5000 SA Gas Plumbing Diagram

Notes:

1 Item 1 can be purchased from TA Instruments.

2 Items 2 – 5 are located in the Accessory Kit.

3 Use 99.999% pure nitrogen to reduce moisture.

4 New or recently serviced and calibrated regulator is recommended.

5 Do not use Tygon tubing due to its high moisture permeability.

6 Make sure that the tubing is cut cleanly and squarely on the ends. 

7 Leak check all tubing.

8 Use the supplied gas dryer, PN 200266.001, to prevent moisture buildup.

Item Quantity Description

1
2
3
4
5

1
1
1
1
15 ft

Regulator (not found in kit)
Legris 1/8-inch OD tube to 1/4-inch male NPT (American pipe thread)
Gas dryer, PN 200266.001
Legris “Y” 1/8-inch tube x 1/8-inch tube
Tubing Polyethylene 1/8-inch OD x.030-inch width

See table on next page for
parts list of this diagram.
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Q50, Q500 TGAs

Dimensions (Q50/Q500): Depth 56 cm (22 in), Width 47 cm (19 in), Height 52 cm (21 in)

Weight: 31 kg (68 lbs.); 8.2 kg (18 lbs) additional for built-in transformer for 230V 
operation

Power requirements: 120 VAC, 47–63 Hz, 1.2 kW [10 A] (Installation Category II) - standard furnace
230 VAC, 47–63 Hz, 1.2 kW [5 A] (Installation Category II) - standard furnace
120 VAC, 47–63 Hz, 1.0 kW [8.3 A] (Installation Category II) - EGA furnace
230 VAC, 47–63 Hz, 1.0 kW [4.2 A] (Installation Category II) - EGA furnace
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15–35°C (Note: TGA balance mechanism is sensitive to changes in 
surrounding environmental conditions. For best results, room temperature should 
be regulated to eliminate temperature variations)
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, 
preferably on the ground floor in the building (a marble balance table is 
required for best results), away from pumps, motors, or other devices which 
produce vibrations, and away from exposure to direct sunlight and direct air 
drafts. (Pollution Degree 2 Environment). 
Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Purge Gas(es) Pressure1, 2      
70–140 kPa gauge (10–20 psig)

Cooling Gas (Air) Pressure1 
170–830 kPa gauge (25–120 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gases are connected to the back of the 
instrument using 1/8-inch (O.D.) Polyethylene® tubing and Legris fittings. The Cooling Gas is con-
nected to the back of the instrument using ¼ inch (O.D.) Polyethylene tubing and a Legris fitting. (The 
tubing and fittings are provided in the TGA accessory kit.) Acceptable purge gases include air, nitrogen, 
oxygen, argon and helium

2. Purge gases are required for the balance and furnace/sample areas. Balance purge gas should always be 
inert to protect the balance assembly. Mass flow controllers (MFC) are a standard feature of the Q500 
and Q50. Purge gas flow rates are 40 mL/min and 60 mL/min to the balance and sample areas respec-
tively for the standard furnace. They are 10 mL/min and 90 mL/min to the balance and sample areas for 
the EGA furnace.
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Q600 SDT

Dimensions: Depth 56 cm (22 in), Width 60 cm (23 in), Height 48 cm (19 in)

Weight:
Weight with transformer:

32 kg (70 lbs)
40 kg (88 lbs)

Power requirements: 120 VAC, 47–63 Hz, 1.2 kW [10 A] (Installation Category II)
230 VAC, 47–63 Hz, 1.2 kW [5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15–35°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, 
preferably on the ground floor in the building (a marble balance table is 
required for best results), away from exposure to direct sunlight and direct air 
drafts. (Pollution Degree 2 Environment). 
Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Purge Gas(es) Pressure1, 2       
70–140 kPa gauge (10–20 psig)

Cooling Gas (Air) Pressure1 
170–830 kPa gauge (25–120 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gases are connected to the back of the 
instrument using 1/8-inch (O.D.) Polyethylene® tubing and Legris fittings. The Cooling Gas is con-
nected to the back of the instrument using ¼ inch (O.D.) Polyethylene tubing and a Legris fitting. (The 
tubing and fittings are provided in the SDT accessory kit.) Acceptable purge gases include air, nitrogen, 
oxygen, argon and helium.
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Q400 TMA

Dimensions Depth 56 cm (22 in), Width 46 cm (18 in), 
Height with furnace open 65 cm(26 in); Height with furnace closed 61 cm (24 in)

Weight:
Weight with transformer:

32 kg (70 lbs)
40 kg (88 lbs)

Power requirements: 120 VAC, 47–63 Hz, 1.2 kW [10 A] (Installation Category II)
230 VAC, 47–63 Hz, 1.2 kW [5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15–35°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, 
preferably on the ground floor in the building (a marble balance table is 
required for best results), away from exposure to direct sunlight and direct air 
drafts. (Pollution Degree 2 Environment). 
Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Purge Gas(es) Pressure1, 2 
70–140 kPa gauge (10–20 psig)

Cooling Gas (Air) Pressure1 
170–830 kPa gauge (25–120 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gases are connected to the back of the 
instrument using 1/8-inch (O.D.) Polyethylene® tubing and Legris fittings. The Cooling Gas is con-
nected to the back of the instrument using ¼ inch (O.D.) Polyethylene tubing and a Legris fitting. (The 
tubing and fittings are provided in the TMA accessory kit.) Acceptable purge gases include air, nitrogen, 
oxygen, argon and helium.

2. A mass flow controller (MFC) is a standard feature and is used to regulate the purge gas. Typical purge 
rates are 100 mL/min. If your instrument does not have an MFC, an external flow meter is required.
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Q800 DMA

Dimensions Depth 56 cm (22 in), Width 46 cm (18 in), 
Height with furnace open 71 cm(28 in); Height with furnace closed 56 cm (22 in)

Weight:
Weight with transformer:

32 kg (70 lbs)
40 kg (88 lbs)

Power requirements: 120 VAC, 47–63 Hz, 600 W [5 A] (Installation Category II)
230 VAC, 47–63 Hz, 600 W [2.5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15–35°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, preferably 
on the ground floor in the building (a marble balance table is required for best 
results), away from exposure to direct sunlight and direct air drafts. (Pollution 
Degree 2 Environment). 
Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Air Bearing Gas Pressure1, 2 
410-450 kPa gauge (60–65 psig); flow rate 2 L/min

Cooling Gas (Air) Pressure1 
170–830 kPa gauge (25–120 psig)

1. All gases must be dry and free of oil, dirt and water. The Cooling Gas is connected to the back of the 
instrument using ¼ inch (O.D.) Polyethylene® tubing and a Legris fitting. (The tubing and fittings are 
provided in the DMA accessory kit.)

2. TA Instruments' Air Compressor Accessory (ACA) is available for laboratories that do not have a suit-
able gas supply for the air bearings.
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VTI-SA / VTI-SA+

Dimensions:1

VTI-SA
VTI-SA+

1. Allow for additional room to the sides and back of the unit for access during installation and mainte-
nance.

Depth 42 cm (16.5 in), Width 30.5 cm (12 in), Height 64 cm (25 in)
Depth 44.5 cm (17.5 in), Width 43 cm (17 in), Height 67 cm (26.5 in)

Weight:
VTI-SA
VTI-SA+

32 kg (71 lbs) 
40 kg (89 lbs)

Software requirements: Microsoft Excel® 2007 or newer with Solver Add In, English version (not supplied)

Power requirements: Three 120 or 230 VAC electrical outlets are required for connecting the instrument, 
computer and monitor on a grounded breaker with a minimum of 20 or 15 
(230 VAC) amps available. 
120 VAC, 47–63 Hz [1.5 A] (Installation Category II)
230 VAC, 47–63 Hz [0.75 A] (Installation Category II) 1.44 kW max with full 
power delivered through accessory outlets.

Laboratory conditions: Temperature 15–30°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, preferably 
on the ground floor of the building (a marble balance table is strongly 
recommended for best results), away from pumps, motors, or other devices which 
produce vibrations, and away from exposure to direct sunlight and direct air drafts. 
(Pollution Degree 2 Environment). 

Laboratory requirements: Nitrogen gas2 is used to generate the humidity and dry mixtures. 
Dew point < –40°C. 
Gas Pressure 70–140 kPa gauge (10–20 psig); an individual two-stage pressure 
regulator is required.
Distilled water is required for humidity chamber (highest purity available is best).

2. All gases must be dry and free of oil, dirt and water. The nitrogen line is connected to the back of the 

instrument using ¼ inch (O.D.) Polyethylene® or stainless steel transfer line tubing and 6 mm fitting. 
(The fitting at the unit is supplied on the instrument. The ¼-inch tubing and connector at the tank are pro-
vided by the customer.)

Laboratory requirements:
(Organic option)

Requires a ¼ inch or 6 mm OD line from the vent port of the instrument to a fume 
hood, window or other ventilation vehicle, the vent line can be polypropylene 
tubing. 

Additional Requirements for VTI-SA+ Camera Option

Description Requirements

Available PCI slot (1/2-height size) One 1/2-height PCI slot is required for video capture card.

Electrical outlet One 120 or 230 VAC as specified above.
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VTI-SA Plumbing Diagram
Page  23



TGA-HP 50

Dimensions:1 Reactor Cabinet
Depth 108 cm (42.5 in), Width 85 cm (33.5 in), Height 207 cm (81.5 in)

Electrical Control Box
Depth 51 cm (20 in), Width 71 cm (28 in), Height 87 cm (34.25 in)

Weight: TGA-HP 50, with reactor: 91 kg (200 lbs)
Control Box: 50 kg (110 lbs)

Software requirements: Microsoft Excel® 2007 or higher with Solver Add In, English version

Power requirements: Option 1 (UPS):
230 VAC, 47–63 Hz (Installation Category II)
Three (3) separate circuits of 20A, 230–240 VAC Twist-Lock electrical outlets
Three (3) male Twist-Lock connectors to connect instruments to outlets
It is strongly recommended that a 230V, 2KVA UPS with at least seven (7) 
outlets is used (TA Instruments does not provide UPS units). This will power the 
following components:
•  Computer
•  Monitor
•  Balance
•  Cabinet Electrical Control
•  Alarm Control
•  Water Bath
•  Vacuum Pump
•  Mass Spectrometer (if purchased, need additional outlet and cable)

Seven (7) C13 power cables to connect components to the UPS
The remaining two Twist-Lock outlets will provide power for the two unit mains.

Option 2 (No UPS):
230 VAC, 47–63 Hz (Installation Category II)
120 VAC, 47–63 Hz (Installation Category II), depending on locale
Six (6) separate circuits of 20 amps, 230–240 VAC Twist-Lock electrical outlets
Six (6) male Twist-Lock connectors to connect instruments to outlets
These six Twist-Lock outlets will power:
•  Instrument Main 1
•  Instrument Main 2
•  Cabinet Electrical Control
•  Alarm Control
•  Water Bath
•  Vacuum Pump

Three (3) 120 or 240VAC local standard wall outlets to power:
•  Computer
•  Monitor
•  Balance
•  Mass Spectrometer (if purchased, need additional outlet and cable)

Three (3) C13 power cables to connect components to above standard wall outlets
Page  24



Laboratory conditions: Temperature 15–30°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, 
preferably on the ground floor in the building away from pumps, motors, or other 
devices which produce vibrations. 
Away from any type of magnetic field generating equipment, and away from 
exposure to direct sunlight and direct air drafts. (Pollution Degree 2 
Environment). 
It is highly recommended that the customer provide a workstation to support the 
Electrical cabinet, computer terminal and monitor. 
Suggested dimensions: 32" High, 60" wide, and 30" Deep, located no more than 
6 ft from the instrument.

Laboratory requirements: Nitrogen gas2or compressed air to operate the valves (80–90 psi)
One Argon tank (purge gas) and at least one Helium tank, one Nitrogen (UHP) 
tank, and one CO2 tank to perform onsite testing of the units.
Four high-pressure regulators capable of up to 1600 psi
One low-pressure regulator capable of 80–90 psi 
NOTE: For safety reasons, all regulators should have a higher rated maximum 
pressure (roughly 60% higher) than the required output.
Other: Nidaq Data Acquisition Boards - M Series PCI- 6221, 6713(supplied)

Laboratory requirements:
(Organic option)

Requires a ¼ inch or 6 mm OD line from the vent port of the instrument to a fume 
hood, window or other ventilation vehicle; the vent line can be polypropylene 
tubing. 

Other: Nidaq Data Acquisition Board - M Series PCI-6281 (supplied)

1. Allow for additional room to the sides and back of the unit for access during installation and mainte-
nance.

2. All gases must be dry and free of oil, dirt and water. The gas connections are made to the instrument 
using ¼ inch (O.D.) stainless steel transfer line tubing and ¼-inch or 6-mm fitting. (The fitting at the unit 
is supplied on the instrument. The ¼-inch tubing and connector at the tank are provided by the cus-
tomer.)
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TGA-HP 50 Plumbing Diagram
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TGA-HP 150

Dimensions:1 Reactor Cabinet
Depth 108 cm (42.5 in), Width 85 cm (33.5 in), Height 207 cm (81.5 in)

Electrical Control Box
Depth 51 cm (20 in), Width 71 cm (28 in), Height 87 cm (34.25 in)

Weight: TGA-HP 150, with reactor: 91 kg (200 lbs)
Control Box: 50 kg (110 lbs)

Software requirements: Microsoft Excel® 2007 or higher with Solver Add In, English version

Power requirements: Option 1 (UPS):
230 VAC, 47–63 Hz (Installation Category II)
Three (3) separate circuits of 20A, 230–240 VAC Twist-Lock electrical outlets
Three (3) male Twist-Lock connectors to connect instruments to outlets
It is strongly recommended that a 230V, 2KVA UPS with at least eight (8) 
outlets is used (TA Instruments does not provide UPS units). This will power the 
following components:
•  Computer
•  Monitor
•  Balance
•  Balance Control
•  Cabinet Electrical Control
•  Alarm Control
•  Water Bath
•  Vacuum Pump
•  Mass Spectrometer (if purchased, need additional outlet and cable)

Eight (8) C13 power cables to connect components to the UPS
The remaining two Twist-Lock outlets will provide power for the two unit mains.

Option 2 (No UPS):
230 VAC, 47–63 Hz (Installation Category II)
120 VAC, 47–63 Hz (Installation Category II), depending on locale
Seven (7) separate circuits of 20 amps, 230–240 VAC Twist-Lock electrical 
outlets
Seven (7) male Twist-Lock connectors to connect instruments to outlets
These seven Twist-Lock outlets will power:
•  Instrument Main 1
•  Instrument Main 2
•  Cabinet Electrical Control
•  Alarm Control
•  Water Bath
•  Vacuum Pump
•  Balance

Three (3) 120 or 240VAC local standard wall outlets to power:
•  Computer
•  Monitor
•  Balance Control
•  Mass Spectrometer (if purchased, need additional outlet and cable)

Three (3) C13 power cables to connect components to above standard wall outlets



Laboratory conditions: Temperature 15–30°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, 
preferably on the ground floor in the building away from pumps, motors, or other 
devices which produce vibrations. 
Away from any type of magnetic field generating equipment, and away from 
exposure to direct sunlight and direct air drafts. (Pollution Degree 2 
Environment). 
It is highly recommended that the customer provide a workstation to support the 
Electrical cabinet, computer terminal and monitor. 
Suggested dimensions: 32" High, 60" wide, and 30" Deep, located no more than 
6 ft from the instrument.

Laboratory requirements: Nitrogen gas2or compressed air to operate the valves (80–90 psi)
One Argon tank (purge gas) and at least one Helium tank, one Nitrogen (UHP) 
tank, and one CO2 tank to perform onsite testing of the units.
Four high-pressure regulators capable of up to 1600 psi
One low-pressure regulator capable of 80–90 psi 
NOTE: For safety reasons, all regulators should have a higher rated maximum 
pressure (roughly 60% higher) than the required output.
Other: Nidaq Data Acquisition Boards - M Series PCI- 6221, 6713(supplied)

Laboratory requirements:
(Organic option)

Requires a ¼ inch or 6 mm OD line from the vent port of the instrument to a fume 
hood, window or other ventilation vehicle, the vent line can be polypropylene 
tubing. 

Other: Nidaq Data Acquisition Board - M Series PCI-6281 (supplied)

1. Allow for additional room to the sides and back of the unit for access during installation and mainte-
nance.

2. All gases must be dry and free of oil, dirt and water. The gas connections are made to the instrument 
using ¼ inch (O.D.) stainless steel transfer line tubing and ¼-inch or 6-mm fitting. (The fitting at the unit 
is supplied on the instrument. The ¼-inch tubing and connector at the tank are provided by the cus-
tomer.)
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TGA-HP 150 Plumbing Diagram
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TGA-HPs (Formerly TGA-HP150s)

Dimensions:1 Reactor Cabinet
Depth 108 cm (42.5 in), Width 85 cm (33.5 in), Height 207 cm (81.5 in)

Electrical Control Box
Depth 51 cm (20 in), Width 71 cm (28 in), Height 87 cm (34.25 in)

Weight: TGA-HPs, with reactor: 182 kg (400 lbs)
Control Box: 50 kg (110 lbs)

Software requirements: Microsoft Excel® 2007 or higher with Solver Add In, English version

Power requirements: Option 1 (UPS):
230 VAC, 47–63 Hz (Installation Category II)
Three (3) separate circuits of 20A, 230–240 VAC Twist-Lock electrical outlets
Three (3) male Twist-Lock connectors to connect instruments to outlets
It is strongly recommended that a 230V, 2KVA UPS with at least eight (8) 
outlets is used (TA Instruments does not provide UPS units). This will power the 
following components:
•  Computer
•  Monitor
•  Balance
•  Balance Control
•  Cabinet Electrical Control
•  Alarm Control
•  HPLC Pump
•  Vacuum Pump
•  Mass Spectrometer (if purchased, need additional outlet and cable)

Eight (8) C13 power cables to connect components to the UPS
The remaining two Twist-Lock outlets will provide power for the two unit mains.

Option 2 (No UPS):
230 VAC, 47–63 Hz (Installation Category II)
120 VAC, 47–63 Hz (Installation Category II), depending on locale
Six (6) separate circuits of 20 amps, 230–240 VAC Twist-Lock electrical outlets
Six (6) male Twist-Lock connectors to connect instruments to outlets
These six Twist-Lock outlets will power:
•  Instrument Main 1
•  Instrument Main 2
•  Cabinet Electrical Control
•  Alarm Control
•  Vacuum Pump
•  Balance

Four (4) 120 or 240VAC local standard wall outlets to power:
•  Computer
•  Monitor
•  Balance Control
•  HPLC Pump
•  Mass Spectrometer (if purchased, need additional outlet and cable)

Three (3) C13 power cables to connect components to above standard wall outlets
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Laboratory conditions: Temperature 15–30°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, 
preferably on the ground floor in the building away from pumps, motors, or other 
devices which produce vibrations. 
Away from any type of magnetic field generating equipment, and away from 
exposure to direct sunlight and direct air drafts. (Pollution Degree 2 
Environment). 
It is highly recommended that the customer provide a workstation to support the 
Electrical cabinet, computer terminal and monitor. 
Suggested dimensions: 32" High, 60" wide, and 30" Deep, located no more than 
6 ft from the instrument.

Laboratory requirements: Nitrogen gas2 or compressed air to operate the valves (80–90 psi)
One Argon tank (purge gas) and at least one Helium tank, one Nitrogen (UHP) 
tank, and one CO2 tank to perform onsite testing of the units.
Four high-pressure regulators capable of up to 1600 psi
One low-pressure regulator capable of 80–90 psi 
One low-pressure regulator capable of 20–30 psi 
NOTE: For safety reasons, all regulators should have a higher rated maximum 
pressure (roughly 60% higher) than the required output.
Other: Nidaq Data Acquisition Boards - M Series PCI- 6221, 6713(supplied)

1. Allow for additional room to the sides and back of the unit for access during installation and mainte-
nance.

2. All gases must be dry and free of oil, dirt and water. The gas connections are made to the instrument 
using ¼ inch (O.D.) stainless steel transfer line tubing and ¼-inch or 6-mm fitting. (The fitting at the unit 
is supplied on the instrument. The ¼-inch tubing and connector at the tank are provided by the cus-
tomer.)
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TGA-HPs Plumbing Diagrams
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Requirements for Miscellaneous Thermal 
Analysis Accessories

Refrigerated Cooling System (RCS40/90) for use with DSC 
Instruments
See the figure below (an RCS40) for the correct placement of the RCS40 or RCS90 unit on the laboratory
bench to the left of the QDSC instrument.

Below is a schematic showing you how to connect the gas plumbing lines to the instrument for the use of
either the RCS40 or RCS90.

Specification RCS90 RCS40

Height
Width
Depth

46 cm (18 in) 
26 cm (10 in)
51 cm (20 in)

26 cm (10 in)
26 cm (10 in)
51 cm (20 in)

Power requirements 120 VAC/12 A/60 Hz
220 VAC/6 A/50 Hz

120 VAC/6.25 A/60 Hz
220 VAC/4 A/50 Hz

Weight 47.7 kg (105 lbs) 24.8 kg (55 lbs)

Laboratory requirements Same general environmental requirements as DSC. A base and cooling purge 
(nitrogen) is required in addition to the standard cell purge. 
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RCS40/RCS90 Gas Plumbing Diagram

Notes:

1 Items 1 and 7 can be purchased from TA Instruments.

2 Items 2 – 6 are located in the DSC Accessory Kit, 970012.901.

3 Use 99.999% pure nitrogen to reduce moisture

4 New or recently serviced and calibrated regulator is recommended.

5 Do not use Tygon tubing due to its high moisture permeability.

6 Make sure that the tubing is cut cleanly and squarely on the ends. 

7 Leak check all tubing.

8 Use gas dryer, PN 200266.001, to prevent moisture buildup.

Item Quantity Description

1 1 Regulator (not found in kit)

2 1 Legris 1/4-inch OD tube to 1/4-inch male NPT (American pipe thread)

3 1 Legris 1/4-inch OD tee x 1/8-inch OD tube

4 1 Legris “Y” 1/8-inch tube x 1/8-inch tube

5 15 ft Tubing, polyethylene, 1/8-inch OD x.030-inch width

6 25 ft Tubing, Polyflame, 1/4-inch OD x.040-inch width

7 1 Gas dryer, PN 200266.001 (not found in kit)

See table below for parts
list of this diagram.
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Liquid Nitrogen Cooling System (LNCS) for use with     
DSC Instruments
See the figure below for the correct placement of the LNCS unit on the floor to the left of the QDSC
instrument.

On the next page is a schematic showing you how to connect the gas plumbing lines to the instrument for
the use of an LNCS.

Dimensions Width (diameter) 53 cm (21 in), Height 109 cm (43 in)
(Unit designed to be placed on the floor.)

Weight: 52 kg (113 lbs) empty
88 kg (193 lbs) full

Power requirements: 85–264 VAC, 50/60 Hz, 0.18 kW

Laboratory conditions: Temperature 15–35°C
Relative Humidity 5–80% (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, preferably 
on the ground floor in the building (a marble balance table is required for best 
results), away from exposure to direct sunlight and direct air drafts. (Pollution 
Degree 2 Environment). 
Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Same general environmental requirements as DSC. LNCS autofills during usage. 
Should be connected to a 160 L liquid nitrogen tank with pressure of 150–170 kPa 
gauge (22–25 psig). A base and cooling purge (nitrogen) is required in addition to 
the cell purge. Helium cell purge is required when operating below –100°C.
Page  36



LNCS Gas Plumbing Diagram

Item Quantity Description

1 2 Regulator, 0 to 40 psig out (not found in kit)

2 1 92 Nut, CGA-580

3 1 15-3 Nipple CGA-580

4 1 Coupler, female-female 1/4-inch NPT (NPT=American pipe thread)

5 2 Legris plug-in reducer 1/8-inch OD x 1/4-inch OD

6 1 Legris male run Tee 1/4-inch OD x 1/4-inch NPT

7 1 Legris plug 1/4-inch OD

8 1 Legris tee 1/4-inch x 1/8-inch tube

9 1 Legris union “Y” 1/8-inch tube to 1/8-inch tube

10 1 Legris 1/4-inch OD tube to 1/4-inch male NPT

11 1 Legris 1/8-inch OD tube to 1/4-inch male NPT

12 15 ft Tubing, polyethylene, 1/8-inch OD x.030-inch width

13 25 ft Tubing, Polyflame, 1/4-inch

14 1 Gas dryer, PN 200266.001 (not found in kit)

15 1 Purge gas purifier, PN 970425.901 (not found in kit)
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Notes:

1 Items 1, 14, and 15 can be purchased from TA Instruments.

2 Items 2–5 are in the LNCS Accessory Kit (970398.901)

3 Items 6–13 are in the DSC Accessory Kit (970012.901)

4 Use new or recently serviced and calibrated regulators.

5 Do not use Tygon tubing due to its high moisture permeability.

6 Make sure that the tubing is cut cleanly and squarely on the ends.

7 Leak check all tubing.

8 Use 99.999% pure Helium to reduce moisture buildup in the cell.

9 Use the gas dryer, PN 200266.001, to pre-dry and indicate unsatisfactory moisture levels.

10 Use the purge gas purifier, PN 970425.901, to achieve a dewpoint of –180°C.
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Finned Air Cooling System (FACS) for use with DSC 
Instruments
This section provides the laboratory requirements for the FACS and a schematic showing you how to
connect the gas plumbing lines to the instrument for the use of an FACS.

Laboratory requirements:

• Same general environmental requirements as DSC.

• Cooling Gas (Air) Pressure for use with Finned Air Cooling System 
70–830 kPa gauge (25–120 psig)

FACS Gas Plumbing Diagram

Notes:

• Item 1 can be purchased from TA Instruments.
• Items 2–5 are located in the DSC Accessory Kit, 970012.901.
• FACS uses cool gas constantly; therefore clean house air should be used. A filter is recommended.
• Use standard grade nitrogen.
• New or recently serviced and calibrated regulator is recommended.
• Make sure that the tubing is cut cleanly and squarely on the ends. 
• Leak check all tubing.

Item Quantity Description

1 1 Regulator (not found in kit)

2 1 Legris 1/8-inch OD tube to 1/4-inch male NPT (NPT=American pipe thread)

3 1 Legris “Y” 1/8-inch tube x 1/8-inch tube

4 15 ft Tubing, polyethylene, 1/8-inch OD x.030-inch width

5 25 ft Tubing, Polyflame, 1/4-inch OD x.040-inch width

6 1 Gas Dryer, P/N 2006.001 (not found in kit)
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QDSC (with 2nd Gas) Plumbing Diagram
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DMA-RH Accessory

Dimensions of control enclosure

Dimensions of sample chamber 
with attached transfer line

Height: 37 cm (14.5 in)
Width: 30.5 cm (12 in)
Depth: 51 cm (20 in)

Height: 15 cm (5 ¾ in)
Width: 21 cm (8 ¼ in)
Depth: 18.5 cm (7 ¼)
Transfer line length: 2.1 meters (7 feet)

Weight of control enclosure
(without water)

Weight of sample chamber with 
transfer line

27.2 kg (60 lbs) 

3.2 kg (7 lbs)

Electrical inlet power requirements Voltage: 90–265 VAC
Frequency: 45– 65Hz

Energy consumption 0.400 KVA

Laboratory conditions: Temperature 15–35°C
Relative humidity 5% to 80% RH from 15°C to 31°C, decreasing to 66% 
RH at 35°C (non-condensing)
Instrument should be located in a dust-free, vibration-free environment, 
preferably on the ground floor in the building away from pumps, motors, or 
other devices which produce vibrations. 
Away from any type of magnetic field generating equipment, and away 
from exposure to direct sunlight and direct air drafts. (Pollution Degree 2 
Environment). 

Laboratory requirements: Filtered nitrogen with dew point of –40°C or less
Pressure: 138 kPa gauge (20 psi gauge)
Volume: 3 SLPM
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DMA-RH Back Panel Connections

Drain valves

Instrument port

N2/DRY AIR inlet port

Power cord
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Circulator-Based Cooling System (CCS) for use with DSC 
Q2000/Q200/Q20

PolyScience Recirculator Specifications

Dimensions Depth 51 cm (20 in) Width 26 cm (10 in), Height 46 cm (18 in)

Weight: 47.7 kg (105 lbs)

Power requirements: 120 VAC / 12 A / 60 Hz
220 VAC / 6 A / 50 Hz 

CCS Feed Hose

Length: 152 cm (5 ft) insulated from circulator to cooling head

Laboratory requirements: Same general environmental requirements as DSC Q Series. In addition, the CCS 
requires a source of circulating water for operation. This can be a mechanical 
circulator such as the PolyScience Recirculator (see above) or tap water. Before 
CCS installation, verify that a source of low pressure (< 10 psi) circulating water is 
available.

CAUTION: The CCS is compatible with circulation systems operating at working 
pressures below 10 psi. Operation at pressures above 10 psi or connection to a 
pressurized chilled-water cooling loop is not recommended, as it could cause 
failure of the system.
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Photocalorimeter Accessory (PCA) for use with DSC 
Q2000 and DSC Q200

Air Compressor Accessory (ACA) for use with DMA Q800

Gas Cooling Accessory (GCA) for use with DMA Q800

Mechanical Cooling Accessory (MCA) for use with TMA 
Q400

Dimensions Depth 44 cm (17 in) Width 28 cm (11 in), Height 15 cm (6 in)

Weight: 9.4 kg (21 lbs)

Power requirements: 90–132 VAC (3.5 A) / 180–246 VAC (2.0 A), 47–63 Hz; autorange selectable

Laboratory requirements: Same general environmental requirements as DSC Q Series.

Dimensions Depth 38 cm (15 in), Width 38 cm (15 in), Height 23 cm (9 in)

Weight: 10 kg (22 lbs)

Power requirements: 120 VAC, 50/60 Hz, 0.3 kW 

Laboratory requirements: Same general environmental requirements as DMA. Should not be located in an 
enclosed area. Heat build-up occurs if air does not flow freely around the unit.
Requires the use of a moisture filter regulator with autodrain, which is included 
with the DMA.

Dimensions Width (diameter): Dewar 46 cm (18 in), Feet 79 cm (31 in); Height: 107 cm (42 in) 

Weight: 46 kg (101 lbs.) - empty
87 kg (191 lbs) - full

Power requirements: 120 VAC at 0.9 kW, 47–63 Hz

Laboratory requirements: Same general environmental requirements as DMA. GCA is refilled by connecting 
to a 160 L liquid nitrogen tank with pressure of 150–170 kPa gauge (20–25 psig).

Dimensions Depth 38 cm (15 in), Width 46 cm (18 in), Height 53 cm (21 in) 

Weight: 50 kg (110 lbs)

Power requirements: 115 VAC, 60 Hz, 1 kW
230 VAC, 50 Hz, 1.2 kW

Laboratory requirements: Same general environmental requirements as TMA. No additional purge gas 
requirements.
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Mechanical Cooling Accessory 70 (MCA70) for use with 
TMA Q400/Q400EM

ThermoStar™ Mass Spectrometer for use with TGAs

Dimensions Depth 51 cm (20 in), Width 26 cm (10 in), Height 46 cm (18 in)

Weight: 47.7 kg (105 lbs)

Power requirements: 120 VAC / 12 A / 60 Hz
220 VAC /6 A / 50 Hz

Laboratory requirements: Same general environmental requirements as TMA. No additional purge gas 
requirements.

Dimensions1

1. The Mass Spectrometer (MS) must be in close proximity (51 cm [20 in]) to the TGA and to the left side 
of the TGA. For sensitive TGA readings, it is recommended the MS be on a separate bench than the 
TGA.

Depth 54.5 cm (21.5 in), Width 30.5 cm (12 in), Height 39.5 cm (15.6 in)
plus approximately 10.2 cm (4 in) clearance in each direction for cooling and 
access.1

Weight: Bench must be able to support 35 kg (77 lbs)

Power requirements: 120 VAC / 10 A 

Laboratory requirements: TGA must be installed and tested. Support bracket must be installed on TGA and 
trigger cable available (from TA Instruments).
Helium (preferred) or argon purge gas (99.999% purity) for the TGA is required to 
allow the standard calcium oxalate test to be performed. Helium is recommended 
for regular TG-MS work due to helium’s low mass, which does not interfere with 
gas products from samples.
Available Ethernet connection.
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